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Student data files needed for this workshop: You will save your file as:

  pm01ch01CharityGolfTournament_LastFirst.mpp   No data file needed

Painted Paradise Golf Resort— 
Annual Charity Golf Tournament

The Painted Paradise Golf Resort will be holding its annual charity golf tourna-

ment to raise money for the purchase of textbooks to be donated to selected 

elementary schools in Santa Fe, New Mexico. The vice president (VP) of special 

projects, Julie Rholfing, has assigned Patti Rochelle, the tournament planning 

manager, to be the project manager of this event. Julie has asked Patti to use 

Microsoft Project 2016 to begin planning this year’s tournament. Before Patti 

can begin entering in the tasks that need to be completed for the tournament, 

she must first understand the Project 2016 window, Project 2016 views, and 

the Project 2016 calendar. You will help Patti get 

started with the setup of this project.

OBJECTIVES

Microsoft Project 2016

Prepare Case Information 
Technology

PLAN A PROJECT

Nmedia/fotolia
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2 CHAPTER 1 | Microsoft Project 2016

Preparing a Project Plan
It is common today to work with teams or with groups of people to reach a desired out-
come. Outcomes can be reached by brainstorming, communicating, planning, and then 
completing the plan as defined. Whether you work on a team or work alone, taking the 
time to plan before acting may help improve your chances of success. The process of plan-
ning and following through with a plan is project management.

In this chapter, you will be introduced to project management terminology and pro-
cesses. Then you will learn how to get started using Project 2016, a project planning 
application often used to help create detailed project plans.

Understand Project Management and  
Microsoft Project Terminology
Project management is a process of initiating, planning, executing, monitoring, and 
closing a project’s tasks and resources in order to accomplish a project’s goal. A project 
goal is the desired result of a project upon completion. A project’s goal is met when proj-
ect tasks are completed on time, on budget, and within the scope of a given project. All 
projects, large or small, should follow the project management process groups, as shown 
in Table 1, to reach project success.

Process Group Responsibility
Initiating Set a project goal; identify a project schedule; define a project budget

Planning Enter project tasks; determine task relationships; assign project  
resources

Executing Produce results; report results

Monitoring and 
Control

Update tasks as in progress or completed; manage resources

Closing Analyze performance; prepare final reports

Table 1 Project management process groups

If you are new to project management, you are not alone! There are many resources available for 
project managers who seek assistance with project management information and practices. One 
resource is A Guide to the Project Management Body of Knowledge (PMBOK® Guide). This guide 
defines project management terminology and presents industry standard guidelines for managing 
projects.

Another resource is the Project Management Institute (PMI). By joining PMI, project managers 
can get access to PMI publications, stay updated on global standards, have networking opportunities  
with other project managers, and have access to project management tools and templates to help 
manage projects. PMI also provides training and access to the Project Management Professional 
(PMP) certification.

O�ce.microsoft.com o�ers videos on Project 2016. This is a helpful resource for project  
managers who may be new to using the software.

REAL WORLD ADVICE Resources for Project Managers

A project manager is the person responsible for overseeing all the details of the 
project plan. The project manager works to create a plan that will lead to project success. 
A project manager also motivates project team members to achieve the project goals. 
Project managers may choose to use project planning software such as Project 2016 to 
help them plan and achieve project success. Project planning software keeps track of 
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tasks, the duration to complete tasks, scheduled dates, project resources, and project costs 
organized in one location for a more e�cient way of managing a project. It is a tool that 
allows project managers to track, analyze, and summarize project information.

In order to use project planning software, it is important to understand terminology 
associated with the software. A task is an activity that is completed to reach a project 
goal. For example, when planning for a charity golf tournament, a task could be “set 
tournament date and time” or “prepare preliminary budget.”

Task duration is the prediction of time it will take to complete a task. Task dura-
tions in Project can be entered in minutes, hours, days, weeks, months, and years. For 
example, it may be determined it takes two days to “set tournament date and time” but 
two weeks to “prepare preliminary budget.”

A predecessor task is a task that must be completed before the next task can start.  
A task that has a predecessor is called a successor task. Project managers often use 
the term task dependency when referring to how the predecessor or successor tasks are  
connected. A task dependency is a relationship between two tasks that defines which task(s) 
have to finish before the next task(s) can start. A task dependency is often called a task link.

Since not all tasks are the same in a project, scheduling them the same way may not 
be an option. Therefore, some tasks may have constraints applied. A constraint is a limi-
tation set on a task. For example, a task of “create tournament website” may have a con-
straint of “finish no later than” a certain date to ensure the website is up and running in 
time to gather enough registrations for the event. Constraints on tasks a�ect how the task 
is scheduled. Setting constraints on tasks will determine how Project 2016 will schedule 
a task. Besides setting specific date constraints on a task, the following task constraints 
can be set on an individual task:

•	 As late as possible

•	 As soon as possible

•	 Finish no earlier than

•	 Finish no later than

•	 Must finish on

•	 Must start on

•	 Start no earlier than

•	 Start no later than

A resource is work, a material, or a cost associated with a project task. Work 
resources are people and equipment. Material resources are resources consumed during 
the project. Cost resources are independent costs associated with a task. For example, a 
task of “provide transportation from the airport” may have a cost of “$2,000 limousine 
service.” Project managers assign resources to project tasks to help determine a project’s 
schedule and a project’s cost.

The scope of a project is what must be completed to deliver a specific product or 
service. The project scope includes the meeting of project goals, tasks, and deadlines set. 
Project managers use planning software such as Project 2016 to prevent deviating from 
the scope of a project.

A milestone is a task that is used to communicate project progress or mark a significant 
point in a project such as the end of a project phase. Milestones are entered into the Project 
2016 software as a task with zero duration. For example, a milestone for the charity golf 
tournament could be “tournament website goes live.” By default, Project 2016 displays a 
milestone as a diamond in the Gantt chart. A Gantt chart is a graphical representation of 
tasks where tasks are shown against a timeline displayed as horizontal bars in which the 
length of the bar is determined by the activities durations and start/finish dates.
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Starting a Project

You have been asked to work on the planning team for the Painted Paradise Golf Resort 
Charity Golf Tournament. Your role on the team will be to set up a project plan in Project 
2016. To get started, you will open and save a project.

In this exercise, you will start, save, close, and open a project.

To Begin, Save, Close, and Open a Project
a. On the taskbar, click Ask me anything or Search the web and Windows.  

Type proj.

b. Click Project 2016 in the search results. The Project Start screen is displayed.

PM01.00 

Figure 1 Creating a new project

c. Click Blank Project to open a new blank project.

d. Click the File tab, and then click Save As.

e. Click Browse, and then navigate to the location where you are saving your files.

f. Click in the File name box, and then type pm01ch01CharityGolfTournament_
LastFirst, using your last name and first name. Click Save.

g. Click the File tab, and then click Close. The project file will close, but the Project 
application will remain open.

If Project 2016 closed completely, perform steps a–b again. Click the File tab, and then click 
Open. Browse to where you store your files, and then click pm01ch01CharityGolfTournament_
LastFirst.mpp. Click Open. You could also perform step a–b again, and then click the file 
name in the left pane to reopen the file.

Troubleshooting
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h. In the Navigation Pane, click Open, and then browse, if necessary, to locate 
pm01ch01CharityGolfTournament_LastFirst.mpp.

i. Click pm01ch01CharityGolfTournament_LastFirst.mpp, and then click Open to 
reopen your project file.

Explore the Project 2016 Window
When opening a new Project 2016 file, the default view is the Gantt Chart view, as 
shown in Figure 2. There may be slight di�erences with the view of your Project 2016 
window. You will learn how to adjust the Project 2016 window in this chapter.

Ribbon

Indicators column

Select All

Row selector

View Bar

Entry table

Gantt chart

Split bar

Timeline

Timescale

Nonworking days

View buttons

Task Mode column

Task Name column

Figure 2 Project 2016 window 

Gantt Chart view lists task details in the Entry table on the left side of the window 
and displays each task graphically in the Gantt chart on the right side of the window. In 
the Gantt chart, a project’s tasks are shown against a timeline. The activities are displayed 
as horizontal bars in which the length of the bar is determined by the duration of the 
activities and start/finish dates. The Entry table is used to enter task information and is 
located to the left of the Gantt chart. The Entry table contains columns and rows similar 
to Microsoft Excel 2016. The Entry table is used to record project tasks, durations, pre-
decessors, and resources. Each task becomes a new row in the Entry table. A vertical split 
bar separates the Entry table and the Gantt chart. If desired, the split bar can be dragged 
to resize the panes.

A row selector is the box containing the row number of a task in the Entry table. 
The Select All button is a button that selects all tasks and task information in the Entry 
table.

The Timeline is a visual representation of the project from start to finish.  
The Timeline is displayed above the Entry table and Gantt chart and below the ribbon. 
You can choose what to display on the Timeline. If the Timeline is added, it will be  
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6 CHAPTER 1 | Microsoft Project 2016

visible in the other Project 2016 views as well. The timescale is located above the Gantt 
chart. The timescale displays the unit of measure that determines the length of the Gantt 
bars in the Gantt chart.

The light gray vertical bars in the Gantt chart represent nonworking days. A 
nonworking day is a day during which Project 2016 will not schedule work to occur. 
Therefore, if a task starts at 8:00 AM on a Friday and has a three-day duration, Project 
2016 would schedule the task for Friday 8:00 AM–5:00 PM, Monday 8:00 AM–5:00 
PM, and Tuesday 8:00 AM–5:00 PM.

The Indicators column is a column in the Entry table that will display an icon that 
provides further information about a task. For example, if the constraint of a specific date 
is set to a task, a calendar icon would appear in the Indicators column.

The Task Mode column indicates the mode in which Project 2016 will schedule 
tasks, either manually or automatically. A task’s mode can be adjusted by using the Task 
Mode arrow within the Task Mode column.

The Task Name column is a location in the Entry table where the name of each 
task is entered. One task is entered per row. Task names should be descriptive but not 
too wordy.

The View Bar is a vertical bar on the left-hand side of the Project 2016 window that 
contains buttons for quick access to di�erent Project 2016 views. The View Bar can be 
turned on and o� based on a project planner’s preference. Use the View Bar’s navigation 
buttons to easily navigate within the di�erent Project 2016 views.

Project 2016 uses the O�ce 2016 design and layout of the ribbon as shown in  
Figure 2. The ribbon is a row of tabs with buttons that appears at the top of the Project 
2016 window. The ribbon may be open as shown in Figure 2 or may also be collapsed to 
save screen space.

The Quick Access Toolbar appears in the top-left corner of the Project 2016 window 
as shown in Figure 3. The Quick Access Toolbar is a series of small icons for commonly 
used commands. The default icons on the Quick Access Toolbar are the Save, Undo, 
and Redo buttons. If using a touch-enabled laptop, you may also see the Touch/Mouse 
Mode button as a default button on the Quick Access Toolbar. However, you can modify 
the Quick Access Toolbar to fit your project needs by adding or removing buttons. For 
example, reports from Project 2016 often need to be printed, and time could be saved by 
adding the Print Preview button to the Quick Access Toolbar.

Modifying the Quick Access Toolbar and Collapsing the Ribbon

Since you are sharing the project with other team members, you want to be sure you 
always have proper spelling in your project plan. Project 2016 does not automatically 
check for proper spelling; therefore, you decide to add the Spelling button to your proj-
ect’s Quick Access Toolbar.

In this exercise, you will modify the Quick Access Toolbar and collapse the  
ribbon.
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To Modify the Quick Access Toolbar and Collapse the RibbonPM01.01

SIDE NOTE 
View Bar
If the View Bar is not 
visible on the left-hand 
side of the Project 2016 
window, right-click the 
vertical text GANTT 
CHART on the left-hand 
side of the window and 
click View Bar.

a. Click the Quick Access Toolbar arrow.

Quick Access Toolbar arrow

Figure 3 Quick Access Toolbar shortcut menu 
Microsoft Project 2016, Windows 10, Microsoft Corporation

b. Click More Commands.

c. Click the Choose commands from arrow.

Choose commands from arrow

All Commands option

Figure 4 Project Options dialog box to customize the Quick Access Toolbar
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8 CHAPTER 1 | Microsoft Project 2016

d. Click All Commands, and then scroll through the list of commands. Click  
Spelling.SIDE NOTE 

Modifying the Quick 
Access Toolbar
You can also add but-
tons to the Quick Access 
Toolbar by right-clicking 
a button on the ribbon 
and clicking Add to 
Quick Access Toolbar.

Add buttonSpelling button

Figure 5 Project Options dialog box 

e. Click Add, and then click OK. The Spelling button  will be added to the Quick 
Access Toolbar.

Modified Quick Access Toolbar

Figure 6 Modified Quick Access Toolbar 
Microsoft Project 2016, Windows 10, Microsoft Corporation

f. Double-click the Task tab. Notice the ribbon is now collapsed.

Ribbon collapsed

Figure 7 Ribbon collapsed 
Microsoft Project 2016, Windows 10, Microsoft Corporation
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g. Double-click the Task tab again to show the ribbon.

h. Right-click the Task tab.

Collapse the Ribbon selection

Figure 8 Collapsing the ribbon 
Microsoft Project 2016, Windows 10, Microsoft Corporation

i. Click Collapse the Ribbon. The ribbon is now collapsed.

j. Right-click the Task tab again. Click Collapse the Ribbon to show the ribbon.

k. On the Quick Access Toolbar, click Save .

Prepare a Project Schedule
Project 2016 has a complex scheduling engine, so to understand how it will calculate  
a project’s schedule, it is important to review the Project Information dialog box.  
The Project Information button is found in the Properties group on the Project tab. Click 
the Project Information button to open the Project Information dialog box.

The Project Information dialog box is used to update various aspects of a project 
such as the project’s start date or finish date, current date, status date, project base calen-
dar, etc. Before entering specific task information for a project, the project’s information 
should be identified. First, one must select whether the project will be scheduled from 
Start date or from Finish date. Project Start date is the date Project 2016 uses to schedule 
tasks that will calculate the project’s Finish date. Scheduling a project by Start date is the 
most commonly used scheduling method. Project Finish date is the date Project 2016 
uses to schedule tasks that will calculate the project’s Start date. Scheduling projects by 
Finish date, while less common, helps determine the latest date a project can start and 
still finish by that finish date. A project can only be scheduled by Start date or Finish 
date, not by both. Start date is the default in the software.

If a project is set to calculate by Start date, as shown in Figure 9, all tasks will be 
scheduled to begin as soon as possible. If you schedule by Start date, Project 2016 will 

Figure 9 Project Information dialog box
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10 CHAPTER 1 | Microsoft Project 2016

calculate when the project should finish. The Finish date would be determined by indi-
vidual tasks, task durations, task predecessors, and resources assigned to tasks.

If a project is set to calculate by Finish date, all tasks will be scheduled to begin as late 
as possible, as shown in Figure 10. If the project is scheduled by Finish date, Project 2016 
will determine the date you must begin your project to be able to complete the project 
by the set finish date. The Start date would be determined by individual tasks, task dura-
tions, task predecessors, and resources assigned to tasks.

Figure 10 Project Scheduled by Finish date

CONSIDER THIS Scheduling by Finish Date

While most projects are scheduled by Start date, you may need to schedule your project by Finish date 
to determine the latest date you can start the project. If you schedule a project by Finish date, it may be 
wise to switch back to scheduling from the Start date when work on the project begins. Projects sched-
uled by Start date help to show the progress of your project and to keep track of factors and situations 
that might cause the Finish date to change.

The Current date is today’s date as determined by your computer’s clock. The cur-
rent date can be changed by entering a new date in the Current date section of the Project 
Information dialog box or by clicking the arrow for Current date and selecting a new date.

The Status date is the date set to run reports on a project’s progress. For example, if 
a weekly team meeting is on Monday morning to review the current status of the project 
for the week ahead, the Status date may be set to the Friday before the Monday morning 
meeting. To run status reports, a project baseline must be set. A baseline is a record of 
each task at a point in time from which you will track project progress.

Project 2016 determines a project’s schedule o� the base calendar. A base calendar is 
the calendar applied to the project in the Project Information dialog box and provides a 
template for how the software will schedule tasks and resources. The default base calen-
dar is the Standard calendar. The Standard calendar specifies hours in which work can 
occur. These hours are referred to as working time. If a project is set to schedule based 
on the Standard calendar, all tasks and each resource are scheduled according to this cal-
endar. The Standard calendar is based on a 40-hour work week with an 8-hour work day 
(8:00 AM to 12:00 PM and 1:00 PM to 5:00 PM) Monday through Friday. Saturday and 
Sunday are considered nonworking days. If you recall, nonworking days are days which 
Project 2016 will not schedule any work to be completed.

Other available predetermined calendar choices are shown in Figure 11. The  
24 Hours calendar assigns a schedule with continuous work. This type of calendar may 
be assigned to a project that must work around the clock—for example, a mechanical 
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process. The Night Shift calendar assigns a schedule that is sometimes referred to as 
the “graveyard” shift schedule of Monday night through Saturday morning, 11:00 PM to 
8:00 AM, with an hour o� for break time.

Calendar selections

Figure 11 Project calendar choices
Microsoft Project 2016, Windows 10, Microsoft Corporation

Project managers can set the priority of a project in the Project Information dialog box. 
The priority of a project is determined on a scale of 1 to 1,000 with 1 being the lowest pri-
ority and 1,000 being the highest priority. A project with a priority of 1,000 is considered 
more important than a project with a priority of 100. Priorities are only used when project 
managers are trying to balance resource assignments among tasks and projects.

Preparing a Project Schedule Using the  
Project Information Dialog Box

Patti Rochelle has asked you to help determine the date for the charity golf tourna-
ment. Therefore, you will use Project 2016 to help calculate a possible tournament date.  
You will begin planning the project at the end of April; therefore, Patti has asked you to 
plan the project start date as of April 30, 2019.

In this exercise, you will change project information.

To Change the Project InformationPM01.02 

SIDE NOTE 
Selecting a Start Date
You can also select a 
start date by using the 
Start date arrow and 
scrolling through the 
calendar until you see 
the desired date.

a. Click the Project tab, and then click Project Information .

b. In the Start date field, type April 30, 2019. In the Current date field, type April 23, 2019.

Figure 12 Project Information dialog box with modified start and current date
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c. Verify the Standard Calendar is selected, and then click OK.

d. Save  the project.

Modify a Project Calendar
Once a base calendar has been assigned to a project, it is important the base calendar 
accurately reflects the working time hours a project team is available to work on the 
project. If not, Project 2016 will calculate an incorrect project schedule that may lead to 
a project’s failure.

Take the charity golf tournament as an example. If the base calendar of the project is 
the Standard calendar, Project 2016 will schedule all tasks on a 40-hour-per-week work-
ing time schedule. If the task of “prepare preliminary budget” is entered with a 1-week 
duration, Project 2016 will schedule 40 hours of work to the task. Project 2016 will 
assign this task a duration of 5 working days (8 hours per day for 5 days for a total of  
40 hours).

Now imagine there are only 20 hours available each week to dedicate to this project 
due to other commitments (not the 40 hours as set by the base Standard calendar). If this 
is the case, the Standard calendar must be modified to reflect the actual working time 
available. If modifications to the calendar are not made, Project 2016 will schedule the 
work incorrectly. To review how Project 2016 schedules tasks based on a project’s calen-
dar, refer to Table 2.

Calendar Task Duration Working Time
Standard calendar with a 
40-hour work week

1 week duration = 40 hours 
of work

5 days (40 hours/8 hours  
per day = 5 days)

Modified Standard calendar 
with a 20-hour work week

1 week duration = 40 hours 
of work

10 days (40 hours/4 hours 
per day = 10 days)

Table 2  Duration and start or finish dates

Modifying a Project Calendar

It is possible to adjust the Standard calendar to meet your project needs. Patti Rochelle, 
the project manager for the charity golf tournament, and her project team are only avail-
able to work on this project Tuesday through Friday 8:00 AM to 12:00 PM (16 hours per 
week). You will need to adjust the base Standard calendar to reflect the actual working 
time available.

To Change the Project Calendar Working Time
a. Click the Project tab, if necessary.

b. In the Properties group, click Change Working Time  to open the Change 
Working Time dialog box for the Standard calendar.

PM01.03 
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Work Weeks tab
Details button

Figure 13 Change Working Time dialog box 

Figure 14 Calendar Details dialog box

M
icr

os
of

t P
ro

je
ct

 2
01

6,
 W

in
do

ws
 1

0,
 M

icr
os

of
t C

or
po

ra
tio

n

c. Click the Work Weeks tab in the bottom section of the dialog box, and then click 
the Details button. The Details for dialog box opens.
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d. In the Details for dialog box, click Monday, and then click Set days to nonworking 
time.

Set days to nonworking time
Select day of week

Figure 15 Mondays set to nonworking days

e. Click Tuesday, press and hold S, and then click Friday.

f. Click Set day(s) to these specific working times:.

g. In the specified work times grid, point to row 2, and then click the 2 in row 2. Press 
D to clear the 1:00 PM–5:00 PM work times.

Set day(s) to these
specific working times

Working time in
row 2 deleted

Select day(s) of the week

Figure 16 Specific working time for days of the week

h. Click OK. The base calendar has now been changed to reflect that Mondays are 
nonworking days and Tuesday–Friday working hours are 8:00 AM–12:00 PM.
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Working times changed

Mondays set to nonworking days

Figure 17 Change Working Time dialog box

If necessary, scroll through the calendar in the Change Working Time dialog box 
until you see April 2019.

Troubleshooting

i. Click OK to close the Change Working Time dialog box, and then Save  the 
project.

Adding Exceptions to the Project Calendar

Since all organizations do not observe the same holidays, Project 2016 does not  
include holidays in the Project calendars. If your organization and/or project team 
observes holidays, you should account for them in the project’s calendar. If holidays 
are not accounted for, Project 2016 cannot factor them into the project’s schedule and 
therefore may miscalculate the project schedule by assigning work on a nonworking day. 
Holidays can be added to a project calendar by creating exceptions to a project’s base 
calendar.

In today’s global economy, it is likely you will work for a company that has locations in di�erent 
states or even countries. Therefore, when preparing your project calendar, consideration must be 
given to where your project team members reside. Although many countries consider a typical 
work week Monday through Friday with Saturday and Sunday as nonworking days, some countries 
may work on a 6-day work week or even a 4-day work week. So that Project 2016 has accurate 
information when creating a project’s schedule, it is important that the base calendar accurately 
reflects the availability of all project team members.

REAL WORLD ADVICE 
Working with Microsoft Project 2016  
Around the Globe
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16 CHAPTER 1 | Microsoft Project 2016

Patti Rochelle, the project manager for the charity golf tournament, has clarified 
that the following holidays will be observed by the project sta�: July 4-5, 2019, and 
September 3, 2019. Therefore, you will need to make these days nonworking days in the 
project’s calendar by adding exceptions to the project’s calendar.

In this exercise, you will add exceptions to the project calendar.

To Add Exceptions to the Project Calendar
a. Click the Project tab, if necessary, and then in the Properties group, click  

Change Working Time to open the Change Working Time dialog box once again.

b. On the calendar, click July 4, 2019, press and hold S, and then click  
July 5, 2019.

PM01.04 

If you do not see the correct dates in the Change Working Time calendar, you 
may need to scroll through the calendar until July 2019 is visible.

Troubleshooting

c. In the bottom section of the Change Working Time dialog box, click the  
Exceptions tab, and then click in the first empty cell in the Name column.

d. Type US Independence Day as the first exception, and then press T. Click in  
the next blank row of the Exceptions table. Verify that the dates of July 4-5, 2019, 
have been changed to nonworking days.

Exception displayed
on the calendar

Exception added

Figure 18 Calendar exception added

e. Click in the next empty cell in the Exceptions Name column, and then type 
Company Picnic.

f. Press T, and then click in the Start column.
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g. Click the Start column arrow to display the date picker, change the Start date to 
September 3, 2019, and then press T. Click the Finish column to verify that 
September 3, 2019, is a nonworking day.

Exception displayed
on the calendar

Exception added

Figure 19 Calendar exception added

If an exception is not appearing as a nonworking day in the calendar, click the 
Exception row in the Exceptions Name box, and then click the Details button. 
Set the selected Exception day to Nonworking, and then click OK.

Troubleshooting

h. Click OK to close the Change Working Time dialog box, and then Save  the project.

One size does not fit all when it comes to Project 2016 calendars! To make sure Project 2016 is 
creating an accurate schedule, individual tasks may need to be completed outside of the base 
calendar working time. For example, if the charity golf tournament’s base calendar is set to working 
times of Tuesday–Friday, 8:00 AM to 12:00 PM, but training for event sta� needs to occur from 
1:00 PM to 5:00 PM, a task calendar can be created to reflect the training times of 1:00 PM to 
5:00 PM. Once a task calendar is created, the calendar is applied to the appropriate task(s), and 
Project 2016 is then able to schedule those particular tasks outside of the base calendar working 
times. Task calendars can be created for any task that does not follow the working and nonworking 
times set on the project’s base calendar.

REAL WORLD ADVICE Task Calendars
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Understand Manually Scheduled Versus  
Auto Scheduled Projects
To understand how Project 2016 schedules tasks, it is important to identify if tasks are 
being scheduled manually or automatically. The default in Project 2016 is for tasks to be 
Manually Scheduled. In this mode, you enter a task duration and the task Start date for 
a task, and then Project 2016 will calculate the Finish date. In other words, task dates are 
not calculated or adjusted by Project’s 2016 scheduling engine, even if changes to related 
tasks are made. Project managers who desire more control over the project schedule may 
elect to use manual scheduling.

If a project manager wants to take advantage of Project’s 2016 scheduling engine, 
however, the project would likely be set to Auto Scheduled. If a project is set to Auto 
Scheduled, the project schedule is calculated based on the project’s calendar, project 
tasks and task durations, task dependencies, resource assignments, and any constraint 
dates assigned to tasks. Auto scheduled projects are more structured than manually 
scheduled projects.

Figure 20 displays how Project 2016 is scheduling the two tasks di�erently. Because 
Task 1 is being Manually Scheduled , it has no Start date or Finish date calculated 
by Project 2016 even though a duration of two days has been assigned to the task.  
Task 2 is set to Auto Scheduled , and therefore, the Start date and Finish date are 
calculated by Project 2016 based on the project’s calendar and the task duration. Also 
note the di�erences in the Gantt bars in the Gantt chart from Manually Scheduled to 
Auto Scheduled tasks.

QUICK REFERENCE 

To create a task calendar, click the Project tab, and then:

1. Click Change Working Time in the Properties group.

2. Click the Create New Calendar button, and then enter a name for the task calendar. Click OK.

3. Click the Work Weeks tab.

4. Click the next empty cell in the Name column. Enter a descriptive name and press T, and 
then click in the Start cell.

5. Click the Details button. In the Details dialog box, choose the appropriate option for your task 
calendar. Edit the From and To times as necessary. Click OK in both dialog boxes.

Once the new task calendar is created, it would need to be assigned to specific tasks using the 
Task Information dialog box.

Creating a Task Calendar

Manually Scheduled task identifier

Auto Scheduled task identifier

Figure 20 Manually Scheduled versus Auto Scheduled tasks 
Microsoft Project 2016, Windows 10, Microsoft Corporation
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Table 3 explains additional di¡erences between a manual scheduling and automatic 
scheduling of project tasks.

Manual Scheduling Automatic Scheduling
Duration Can be number, date, or text 

information, such as “4 days” or 
"a few days”

Only numbers can be used that 
represent length and units, such 
as “4 days” or “2 weeks”

Project Calendar Ignored by Project Used by Project to determine a 
project’s schedule

Constraints Ignored by Project Used by Project to determine task 
Start or Finish date

Task Relationships 
(links)

Can be assigned but won’t 
change the task schedule

Can be assigned and will change 
the schedule of a task

Resources Can be assigned to tasks but 
won’t change the task schedule

Can be assigned to tasks. Used 
by Project to help determine best 
schedule

Table 3  Manual scheduling versus automatic scheduling

Auto Scheduling a Project

A project can be set to Auto Scheduled so that all tasks, unless otherwise specified, are 
scheduled by Project’s scheduling engine. If a project is set to Auto Scheduled, individual 
tasks can be changed to Manually Scheduled, if necessary. A project set to Manually 
Scheduled will allow the project manager to determine the Start and Finish dates of 
a project’s tasks. If a project is set to Manually Scheduled, individual tasks can be set 
to Auto Scheduled. To change individual tasks, click the Task tab and then click Auto 
Schedule in the Tasks group or click the arrow in the Task Mode column.

You are asked to set the project to Auto Scheduled so that Project 2016 can help you 
determine when it is possible to hold the charity golf tournament. In this exercise, you 
will change a project to Auto Scheduled.

To Change a Project to Auto Scheduled
a. Click New Tasks: Manually Scheduled on the status bar.

PM01.05 

Scheduling selections

Status bar

Figure 21 Project status bar 
Microsoft Project 2016, Windows 10, Microsoft Corporation

b. Click Auto Scheduled – Task dates are calculated by Microsoft Project. All tasks 
will now be calculated by Project 2016 unless set individually to Manually Scheduled.

c. Save  the project. If you need to take a break before finishing this chapter, now 
is a good time.

SIDE NOTE 
Task Mode Column
The Task Mode column in 
the Entry table will reflect 
how a task is being sched-
uled once a task is entered.

Creating a Project Plan
Understanding project management terminology, exploring the Project 2016 window, 
adjusting the Project 2016 calendar, and choosing a scheduling method are just the start 
to creating a project plan. Time also needs to be spent on identifying project tasks, task 
durations, task dependencies, and task constraints.
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Identify and Enter Project Tasks
Tasks are activities that must be completed to accomplish a project goal. Tasks are entered 
into the Entry table in Gantt Chart view but can also be entered in the Network Diagram 
view and the Calendar view. Task names should be concise, and each task should be 
entered on a separate row in the Entry table. Tasks are assigned durations by the project’s 
manager. In Project 2016, the default for a duration of one day is eight hours. Even if the 
project schedule is set to a 20-hour work week versus a 40-hour work week, Project 2016 
still calculates one day as eight hours by default.

Durations help Project 2016 to calculate a task’s Start (or Finish) date if a project is set to 
Auto Scheduled. Durations can be entered into the software using the following abbreviations:

QUICK REFERENCE 

Duration Abbreviation Result Duration

1 min 1 minute

1 h 1 hour

1 d 1 day (default) or 8 hours

1 w 1 week

1 mon 1 month

Entering Task Durations

Each task in a project is unique from other tasks within the same project, even if the 
tasks are related in some way. Information about a single task can be found in the Task 
Information dialog box by selecting the Information button on the Task tab. The Task 
Information dialog box includes all the details for a single task. Project managers can use 
the Task Information dialog box to view and update task details such as resource assign-
ments, predecessors, and task calendar. Information for a task is divided into six categories 
(tabs): General, Predecessors, Resources, Advanced, Notes, and Custom Fields, as shown 
in Figure 22. You can also use the Task Information dialog box to make changes to a task.

Figure 22 Task Information dialog box

Task names should be brief; therefore, more information may need to be added to a task 
for clarification. This can be done with a task Note. A task Note acts as a sticky note for 
a task and can be added on the Notes tab in the Task Information dialog box. A Note can 
provide more information on a task such as a web link, a phone number, or even an embed-
ded file, such as an Excel spreadsheet, that provides further information on the task.

Navigating around an Entry table uses keystrokes similar to those used in other 
Microsoft applications.
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QUICK REFERENCE 

Keyboard Shortcut Moves the Active Cell

t Up one row in the same column

b Down one row in the same column

r One column to the right

l One column to the left

J Down one row in same column

V + J Up one row in same column

h First column of the current row

e Last column of the current row

C + h First column and row

C + e Last column of the last row

u Up one screen

d Down one screen

T One column to right

V + T One column to left

Navigating the Entry Table

Entering Project Tasks

Now that you have prepared your project plan by adjusting the project calendar, and set-
ting the project to schedule automatically and by start date, you are ready to create your 
project plan. Patti Rochelle, the charity golf tournament planning manager, has given 
you a list of tasks to enter into the project’s Entry table.

In this exercise, you will enter project tasks.

To Enter Project TasksPM01.06 

SIDE NOTE 
Text Wrap
Project 2016 has a Wrap 
Text feature for task 
names. If the name is 
longer than the column, 
the text will wrap within 
the cell.

a. If you took a break, open the pm01ch01CharityGolfTournament_LastFirst  
project.

b. Click in the Task Name cell in row 1. Type Set tournament objectives.

c. Press T. The default value of 1 day? will appear in the Duration column.

Auto Scheduled
symbol

Undetermined
duration

Gantt barTask
name

Figure 23 Entry table with new task default duration 
Microsoft Project 2016, Windows 10, Microsoft Corporation
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d. Type 6h in the Duration column. Press T. Notice how Project 2016  
assigns a Start date and Finish date because your project is set to Auto Scheduled. 
The task is scheduled over two days because there are only four hours available in 
a day to complete a task. Note the Auto Scheduled symbol  in the Task Mode 
column.

SIDE NOTE 
Project-Scheduled 
Changes
Whenever changes are 
made to a¡ect a start or 
finish date of a task(s), 
those dates will be 
highlighted with a light 
colored background.

Duration Adjusted finish date

Figure 24 Entry table with task duration 
Microsoft Project 2016, Windows 10, Microsoft Corporation

SIDE NOTE 
Task Information
You can also open the 
Task Information dialog 
box by double-clicking 
a task.

e. With Set tournament objectives (Task 1) selected, click the Task tab, if neces-
sary, and then in the Properties group, click Information  to open the Task 
Information dialog box. Explore the various tabs that can contain information about 
Set tournament objectives. Click Cancel.

f. Enter the remaining tasks below in the Entry table. Remember you can use abbre-
viations for the durations.

Task Task Name Task Duration
2 Determine project team 4 hours

3 Set tournament date and time 1 day

4 Prepare preliminary budget 6 hours

5 Create tournament website 2 weeks

6 Solicit potential tournament sponsors 1 week

7 Select tournament sponsors 4 hours

8 Solicit celebrity appearances 3 weeks

9 Create volunteer list 4 hours

10 Sign volunteer contracts 1 hour

If the Start or Finish date column displays the date as wrapped text, you may want 
to widen the column. To widen a column, point to the right side of the column 
border in the field name. When your pointer turns into a double-pointed arrow, drag 
to the right until the date displays appropriately. As in Excel, you can also double-
click between the columns to automatically widen the column.

Troubleshooting
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Figure 25 Entry table with tasks added 
Microsoft Project 2016, Windows 10, Microsoft Corporation

g. On the Quick Access Toolbar, click the Spelling  button to check the spelling of 
the task names.

h. Save  the project.

CONSIDER THIS  Task Duration

Why is a task duration of one day being assigned a calendar duration of two days? The Project calendar 
for the charity golf tournament was adjusted to a four-hour working day of 8:00 AM to 12:00 PM. 
Therefore, by entering in a duration of 1d (one day = eight hours), Project scheduled the task to be 
completed over two calendar days: four available hours on day 1 and four available hours on day 2.  
Is using the day duration confusing? Consider entering durations in hours instead.

All the tasks are set to start on the project’s start date. Project 2016 is scheduling 
this way because the project is scheduled by Start date and all tasks are scheduled to start  
As Soon As Possible. Project tasks will push ahead in time as you create a more detailed 
project schedule later in this workshop.

Modify Project Tasks in Project 2016
Project 2016 makes it easy to edit a project plan by adding, deleting, or changing existing 
tasks. As you are planning your project, you may discover that you need to add an addi-
tional task(s) in the middle of your project plan. Project 2016 allows tasks to be inserted 
by using commands on the ribbon, the shortcut menu, or the keyboard. Inserting a task 
in the middle of a project plan is similar to adding a row in Excel 2016 because Project 
2016 will push every subsequent task down one row and adjust the project accordingly.

Adding and Modifying Project Tasks in the Entry Table

After brainstorming at a team meeting, the charity golf tournament planning team has 
identified a few additional tasks to be added to the project plan as well as an adjustment 
to task durations. You will add these tasks.

In this exercise, you will modify a task list.
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To Modify a Task ListPM01.07

b. Type Reserve golf course, and then press T. Type 1h, and then press T. 
Reserve golf course becomes the new Task 4.

c. With Reserve golf course (Task 4) still selected, press the Insert I key. A blank 
row is added above the selected row to create a new task. Notice how a blank row 
is inserted with this method.

SIDE NOTE 
Adding Tasks in the 
Entry Table
Similar to Excel 2016, 
new task rows are added 
above the active row.

a. Click any cell in task row 4, Prepare preliminary budget, and then click the Task 
tab, if necessary. In the Insert group, click the Task  button to insert a new 
row. <New Task> appears as the task name.

New Task row added in Entry table

Task button

Figure 26 New task row added in Entry table 
Microsoft Project 2016, Windows 10, Microsoft Corporation

If you selected the Task arrow instead of the Task button, select Task.

Troubleshooting

Blank row in Entry table

Figure 27 Blank row added in Entry table  
Microsoft Project 2016, Windows 10, Microsoft Corporation
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d. In the Task Name cell for the new Task 4, type Perform site inspections, and then 
press T. Type 4h, and then press T.

e. Click in the Duration column of Task 3, Set tournament date and time, and then 
type 1h to change the duration from 1 day to 1 hour.

f. Select Solicit potential tournament sponsors (Task 8), and then on the Task tab, 
in the Properties group, click Information . If necessary, click the General tab. 
In the upper right-hand corner of the General tab, change the Duration from 1 week 
to 3d.

g. Click the Notes tab. Add the note Contact local sporting goods stores for a list of 
potential sponsors.

Notes tab

Figure 28 Task Information dialog box Notes tab

If your keyboard does not have an Insert key, repeat step a.

Troubleshooting

SIDE NOTE 
Task Changes
When you make changes 
to a task, Project 2016 
will highlight the a¡ected 
tasks in the Entry table 
with a light colored 
 background.

SIDE NOTE 
Task Note
Double-click the Note 
icon or hover over 
the Note icon in the 
Indicators column to 
display the note.

h. Click OK. Notice the Note indicator  in the Indicators column.

i. Point to the note to see the note text.

Task note indicator

Task note ScreenTip

Figure 29 Note indicator in Entry table 
Microsoft Project 2016, Windows 10, Microsoft Corporation

j. Save  the project.
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Deleting Project Tasks in the Entry Table

As a project planner, you may decide a project task is no longer needed. As well as insert-
ing tasks, Project 2016 allows for tasks to be deleted. Deleting a task removes an entire 
task row and moves any subsequent tasks up a row. As with inserting tasks, there are 
several ways to delete tasks in Project 2016 such as using the ribbon, the shortcut menu, 
or the keyboard.

Since the project team for this charity golf tournament is already in place, in this 
exercise, you will delete a task.

QUICK REFERENCE 

In the Entry table, click any cell below the row where you wish to insert a task.

•	 Right-click the row number of the task, and then click Insert Task from the shortcut menu, or

•	 Click the Task button in the Insert group on the Task tab, or

•	 Press Insert on the keyboard.

Inserting a Task

To Delete a Task
a. Right-click the row selector for Determine project team (Task 2).

PM01.08 

Row selector

Shortcut menu

Figure 30 Task shortcut menu

b. Click Delete Task from the shortcut menu. The Determine project team task is 
deleted.

c. Click the row selector for Create volunteer list (Task 10). With the task selected, 
press D. Task 10 is now deleted.

If you press D on the Task Name cell of a task row, Project 2016 will prompt you 
to 1) delete the task name or 2) delete the task. To avoid this prompt, select the 
task row selector, and then press D.

Troubleshooting
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d. On the Quick Access Toolbar, click Undo  to undo the deletion of Task 10.

Figure 31 Entry table with task deleted 
Microsoft Project 2016, Windows 10, Microsoft Corporation

e. Save  the project.

QUICK REFERENCE 

In the Entry table, click any task row you wish to delete.

•	 Right-click the row number of the task, and then select Delete Task from the shortcut menu, or

•	 Click the row selector of the task to be deleted, and then press the Delete key on your  
keyboard, or

•	 Click any cell of a task you want to be deleted, and then in the Editing group, on the Task tab, 
click the Clear button to display the menu. Click Entire Row to delete the task.

Deleting a Task

Moving, Cutting, Copying, and Pasting  
Project Tasks in the Entry Table

Project planners may decide to reorder tasks or even copy tasks. Moving tasks will simply 
reorder tasks within the Entry table. If a task is cut, the task will be temporarily deleted 
and placed on the Project 2016 clipboard. If a task is copied, the task stays in its current 
location but is also placed on the clipboard to be pasted in another location in the Entry 
table. Any tasks on the clipboard can be pasted within the Entry table of the project.

After reviewing the project tasks, you have decided it is important to prepare your 
budget before you perform site inspections. Therefore, you will move Task 5.

In this exercise, you move a task in the Entry table.

To Move a Task
a. Click the row selector for Prepare preliminary budget (Task 5) to select the task.

b. Press and hold the row selector again (you will see a four-arrow pointer). Drag the 
row selector above Perform site inspections (Task 3). As you drag Task 5, a dark 
gray horizontal bar will indicate the position of the task if you were to let go of your 
mouse.

PM01.09 
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Horizontal bar showing placement of moved task

Selected task

Figure 32 Moving a task in the Entry table 
Microsoft Project 2016, Windows 10, Microsoft Corporation

c. Release the mouse button. The Prepare preliminary budget task is now Task 3.

Figure 33 Entry table with task moved Microsoft Project 2016, Windows 10, Microsoft Corporation

If you are having di¢culty moving a task, be sure you first click the row selector 
of a task. Then click the task row selector again and drag the task to the desired 
location.

Troubleshooting

d. Right-click the row selector for Set tournament objectives (Task 1). Click Copy on 
the shortcut menu. Click in row 12, the first blank row, and then on the Task tab in 
the Clipboard group, click Paste  . This creates a copy of the task.

e. Delete the copied task.
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Modifying Project Tasks in Calendar View

The Project 2016 software has several views from which to edit or view your project 
tasks. You can switch from one view to the other using the View Bar, which appears at 
the left-hand side of the project window. Gantt Chart view displays tasks, task durations, 
and task dependencies in a Gantt chart with horizontal bars and is the default view in 
Project 2016. The length of the task bars in the Gantt chart relates to the task detail such 
as duration and the zoom of the timescale at the top of the Gantt chart.

Calendar view displays tasks as bars on a calendar in a monthly format. Calendar 
view may be used to see upcoming weekly or monthly tasks. Managers may also choose 
to print from Calendar view because it gives an overview of the week or month ahead.

Patti Rochelle, the tournament planning manager, has asked you to add additional 
tasks to the charity golf tournament project plan. You decide to make these additions in 
the Calendar and Network Diagram views.

In this exercise, you will add and modify tasks in Calendar view.

When deleting Task 12, be sure to click the row selector for the task.

Troubleshooting

f. Save  the project.

To Add and Modify Tasks in Calendar ViewPM01.10 

SIDE NOTE 
Alternate Method
You can also switch 
views by using the 
Calendar view  on 
the View Bar.

a. Click Create volunteer list (Task 10), and then click the Task tab, if necessary.

b. On the Task tab, in the View group, click the Gantt Chart  arrow, and then click 
Calendar to switch to Calendar view.

Figure 34 Calendar view
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c. In Calendar view, click Week to change the calendar to Week view format.

Figure 35 Week view option in Calendar view

d. With Calendar view in the Week format and Task 10 still selected, click the Task tab, 
if necessary. In the Insert group, click the Task  button to add a new blank task.

New task added

Figure 36 New task added in Calendar view

e. Double-click <New Task>, 1 day? on the Calendar to open the Task Information 
dialog box.
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f. On the General tab of the Task Information dialog box, click in the Name box, and 
then type Begin online registrations. Press T, and then type 0d in the Duration 
box to enter the Milestone task.

Figure 37 Task Information dialog box 
Microsoft Project 2016, Windows 10, Microsoft Corporation

g. Click OK.

New task

Figure 38 Calendar view with new task added 
Microsoft Project 2016, Windows 10, Microsoft Corporation

SIDE NOTE 
Milestone Task
Notice the milestone task 
is identified in the Gantt 
chart as a diamond.

h. Click Gantt Chart  on the View Bar on the left-hand side of the Project 2016 
window to view the new Task 10 in the Gantt chart.

If the View Bar is not visible on the left-hand side of the Project 2016 window, 
right-click the vertical text GANTT CHART on the left-hand side of the Project 2016 
window, and then click View Bar.

Troubleshooting

i. Click in the Task Name cell of Task 10. Click the Gantt Chart Tools Format tab.  
In the Columns group, click Wrap Text  twice to wrap the text of the new task. 
Notice the wrapped text of the task names in the Entry table.
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j. Click the row selector for Begin online registrations (Task 10), and then move 
the task above Solicit potential tournament sponsors (Task 7). Begin online 
 registrations is now Task 7.

Figure 39 Gantt Chart view with new task added and moved 
Microsoft Project 2016, Windows 10, Microsoft Corporation

k. Save  the project.

Modifying Project Tasks in Network Diagram View

Not only can tasks be added in Gantt Chart view and Calendar view, but they can also be 
added and modified in Network Diagram view. Network Diagram view also displays 
tasks and task dependencies. However, this view provides more information by display-
ing each task in a detailed box and clearly representing task dependencies with link lines. 
The Network Diagram also displays the critical path. The critical path consists of tasks 
(or a single task) that determine the project’s Finish date (or Start date); tasks on the criti-
cal path are considered critical tasks. The main purpose of the Network Diagram is to 
assist project managers in viewing the critical path.

Critical tasks are displayed in light red on the network diagram. A critical task must 
be completed on time in order to meet the project’s Finish date (or Start date). A task 
becomes critical based on the task dependencies, task durations, and task resource assign-
ments. Project managers must monitor critical tasks to be sure they are being completed 
on time in order to successfully meet the project schedule. You decide to switch to this 
view and add another project task.

In this exercise, you will add and modify tasks in Network Diagram view.

To Add and Modify Tasks in Network Diagram View
a. With Task 7 still selected, click Network Diagram  on the View Bar to switch 

to Network Diagram view.

PM01.11 

SIDE NOTE 
Identifying a Critical 
Task
Task 10 is a critical task 
because at this point in 
the planning process, 
Task 10 has the longest 
duration.

b. Scroll down the Network Diagram as necessary to view Begin online registrations 
(ID: 7). Note the shape of this task is di¡erent from the other tasks with a rectangle 
shape because Task 7 is a milestone task. Also note the task has a black back-
ground because it is the selected task.

c. Scroll down again until you see Solicit celebrity appearances (Task 10). Note this 
task appears in red because it is a critical task.
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Milestone task

Critical task

Figure 40 Network Diagram view of tasks

SIDE NOTE 
Tasks in Network 
Diagram View
A selected task in the 
Network Diagram will 
appear with a black back-
ground and white text.

d. While still in Network Diagram view, scroll up, and then click Create tournament 
website (Task 6) to select the task.

e. Click the Task tab, and then in the Insert group, click Task  to add a new blank 
task in Network Diagram view. The new blank task becomes Task 6 with Create 
tournament website (Task 7) still selected.

SIDE NOTE 
Adding a New Task in 
the Network Diagram
You can also add a task 
in Network Diagram view 
by clicking in a blank 
area of the Network 
Diagram and dragging to 
draw a small rectangle.

f. Double-click the <New Task> rectangle to open the Task Information dialog box.

If you clicked on the new task’s border, the Format Box dialog box will appear. Click 
Cancel, and then double click inside the task box instead.

Troubleshooting

g. Click the General tab of the Task Information dialog box, add the Name Design 
tournament logo, and then press T.

h. Enter a Duration of 1d, and then click OK. The new task has the task name Design 
tournament logo with a duration of one day.

i. With Design tournament logo (Task 6) still selected, click one time in the Dur: box, 
type 2d, and then press J to change the duration of the task from one day to  
two days.

If the Task 6 Task Information dialog box opened when attempting to adjust the 
duration, you double-clicked the task. Close the Task Information dialog box, and 
then click once to select Task 6.

Troubleshooting
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j. Select Reserve golf course (Task 5). Change the duration of Task 5 to 0d to make 
this task a milestone and change the shape of the task in Network Diagram view.

Task duration changed

New task added

Figure 41 Network Diagram view with task additions and changes

k. Click Gantt Chart on the View Bar to return to Gantt Chart view. Note the new tasks 
and the change in durations.

l. Click Design tournament logo (Task 6). Click the Gantt Chart Tools Format tab, 
and then in the Columns group, click Wrap Text  twice.

m. Save  the project.

CONSIDER THIS How Can You Motivate Team Members?

Have you ever been a member of a team? How did your coach motivate you? Did your coach recognize 
team successes as they occurred? Project successes can be recognized by milestones. Therefore, 
milestones can help motivate the project team by recognizing project accomplishments.

Create Task Dependencies
When creating a project schedule, if you do not define task dependencies, all tasks will 
start on the project Start date or finish on the project Finish date. However, in most 
projects, tasks may be dependent on other tasks. Therefore, Project 2016 allows project 
planners to create task dependencies.

Task dependencies create predecessor tasks and successor tasks. For example, you could 
not begin a task of “begin online registrations” without first completing the task of “set 
tournament date and time.” In this case, “set tournament date and time” would be the 
predecessor task to “begin online registrations” (which then becomes the successor task).  
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Remember, project managers often use the terms relationship, dependency, or link when 
referring to how the predecessor or successor tasks are connected.

CONSIDER THIS  Why Create Task Dependencies?

Have you ever baked a cake? If so, then you know you need to purchase the ingredients before mixing 
them together; mix the ingredients together before pouring them into a pan; prepare the pan before 
pouring in the ingredients; heat the oven before putting the pan into the oven to bake, etc. Baking a 
cake is a project during which tasks are completed in a certain order. This order is defined by task 
dependencies.

There are four types of task dependencies in Project 2016, as shown in Table 4:

Type Detail Example
Finish-to-Start 
(FS)

Default. Task 1 must  
finish before Task 2  
can start.

You must finish selecting the tournament 
date (Task 1) before beginning online  
registration (Task 2).

Start-to-Start 
(SS)

Task 1 must start before 
Task 2 can start.

As soon as the tournament website goes 
live (Task 1), you can start accepting online 
registrations (Task 2).

Start-to-Finish 
(SF)

Task 1 must start before 
Task 2 can finish.

You must start working on the tournament 
website (Task 1) before you can finish  
promotional materials (Task 2).

Finish-to-Finish 
(FF)

Task 1 must finish before 
Task 2 can finish.

You must finish accepting online registrations 
(Task 1) before you finalize the tournament 
supply list (Task 2).

Table 4  Task Dependencies

In Project 2016, task dependencies are recorded in the row for the second (successor) task. 
For example, if you are creating a dependency between “set the tournament date” (Task A) 
and “begin online registrations” (Task B), you record the dependency in the row for Task B.

Dependencies in the software are also often referred to as task relationships or  
task links. Project managers often use these terms interchangeably. If you are manually 
scheduling your project, you can still assign task dependencies. However, if manually 
scheduling, the task dependencies will not a�ect the project schedule.

There are several ways to create task dependencies to the default Finish-to-Start  
relationship:

•	 Select the tasks to be related in Gantt Chart, Network Diagram, or Calendar view, 
and then click the Link the Selected Tasks  button in the Schedule group on the 
Task tab as shown in Figure 42.

•	 Double-click a task in Gantt Chart, Network Diagram, or Calendar view, and then 
click the Predecessors tab. Enter in the task row(s) of the predecessor task(s), and then 
click OK.

•	 In Gantt Chart, Network Diagram, or Calendar view, click the predecessor task and 
drag to the successor task. Release the mouse and the tasks become linked.

•	 In Gantt Chart view, click the successor task to select the task. In the Predecessors  
column, enter the task row(s) of the related task(s), and then press J.

•	 Select the tasks to be related, and then press C + 2.
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Schedule group

Figure 42 Task tab Schedule group 
Microsoft Project 2016, Windows 10, Microsoft Corporation

Adding Task Dependencies

In order to create a more detailed and realistic project plan, you have been asked to create 
task dependencies for the tournament project tasks.

In this exercise, you will set task dependencies.

To Set Task Dependencies
a. In Gantt Chart view, move the split bar between the Gantt chart and the Entry 

table to the right edge of the Predecessors column by dragging the split bar to 
the right.

b. Click and drag to select the Task Names Set tournament objectives (Task 1) and 
Set tournament date and time (Task 2).

PM01.12 

SIDE NOTE 
Task Relationships
Because the project is 
scheduled by Start date, 
the Finish-to-Start rela-
tionship between tasks 1 
and 2 and the start date 
of task 2 changes.

c. Click the Task tab, and then in the Schedule group, click Link the Selected  
Tasks . Linking Tasks 1 and 2 created a Finish-to-Start relationship. Notice 
the link line in the Gantt chart as well as the change to the Start date in Task 2.  
Also notice a “1” was added to the Predecessors column in Row 2.

Change in Start and Finish dates

Task predecessor

Predecessor task

Figure 43 Finish-to-Start relationship between Tasks 1 and 2 
Microsoft Project 2016, Windows 10, Microsoft Corporation

d. Click in the Predecessors column for Prepare preliminary budget (Task 3). Type 2, 
and then press J. Task 2 becomes a predecessor of Task 3.

If you cannot see the Predecessor column in the Entry table, click and drag the 
split bar to the right.

Troubleshooting
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f. Release the mouse button to create a relationship between Tasks 3 and 4.

g. Double-click Reserve golf course (Task 5) to open the Task Information dialog 
box. Click the Predecessors tab. Click in the ID column of the first row of the 
Predecessors table. Enter a 4 in the ID column of the first row, and then press T 
to assign the predecessor of Task 4, Perform site inspections.

Linking line in Gantt chart

Figure 44 Linking tasks in the Gantt chart 

Microsoft Project 2016, Windows 10, Microsoft Corporation

ID column of Task
Information dialog
box Predecessor tab

Figure 45 Assigning predecessors in the Task Information dialog box

h. Click OK, and then select Task 1, Set tournament objectives.

i. On the View Bar, click Network Diagram . Click and hold Set tournament 
objectives (Task 1), and then drag to Design tournament logo (Task 6).

e. In the Gantt chart on the right-hand side of your screen, click and hold the Prepare 
preliminary budget (Task 3) Gantt bar and then drag to the Perform site inspec-
tions (Task 4) Gantt bar.

Microsoft Project 2016, Windows 10, Microsoft Corporation
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Linking line in
Network diagram

Figure 46 Linking tasks in Network Diagram view 
Microsoft Project 2016, Windows 10, Microsoft Corporation

j. Release the mouse button to create a Finish-to-Start relationship between Task 1 
and Task 6.

Figure 47 Linked tasks in Network Diagram view 
Microsoft Project 2016, Windows 10, Microsoft Corporation

SIDE NOTE 
Linking Tasks
When linking tasks in the 
Gantt chart, you will see 
the  Link the Selected 
Tasks symbol as you 
drag from one task box 
to the next.

If you do not see the tasks in Network Diagram view you desire, you may need to 
scroll to the left or right to view the tasks. You can also click the Zoom button in 
the Zoom group on the View tab, and then select from the Zoom In or Zoom Out 
options.

Troubleshooting

Microsoft Project 2016, Windows 10, Microsoft Corporation
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k. Click and hold Prepare preliminary budget (Task 3) and drag to Design tourna-
ment logo (Task 6). Tasks 3 and 6 now have a Finish-to-Start relationship.

SIDE NOTE 
Dragging to Link 
Tasks
If you selected Task 7 
and dragged to Task 6, 
the relationship would 
have a di¡erent result 
than selecting Task 6 
and dragging to Task 7.

Figure 48 Network Diagram view with tasks linked 
Microsoft Project 2016, Windows 10, Microsoft Corporation

 

SIDE NOTE 
Scrolling to Task
To view a task from the 
Entry table that is not 
visible in the Gantt chart, 
right-click the task, and 
then click Scroll to Task.

l. Click Calendar view  in the View Bar. Click and hold Design tournament logo  
(Task 6), and then drag to Create tournament website (Task 7).

If you do not see the tasks you are looking for in Calendar view, be sure your 
Calendar is showing the correct month in which your project tasks are scheduled. 
You may need to change the Calendar to Week view and expand the Week view 
and scroll to the week of May 1, 2019.

Troubleshooting
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Linking line in
Calendar view

Figure 49 Linking tasks in Calendar view

m. Release the mouse button to create a relationship between Tasks 6 and 7.

n. Return to Gantt Chart  view. Select Tasks 7-13 by selecting the task row 
selectors. Press C + 2 to link the selected tasks. All task relationships are now 
defined.

SIDE NOTE 
Selecting Tasks
When you select more 
than one row in an Entry 
table, the selected tasks 
will be shaded.

Figure 50 Gantt Chart view with task relationships defined

o. Click Save .
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Modify Task Dependencies and Task Constraints
Although setting task relationships and task constraints is an important part of the plan-
ning process, it is equally important for project managers to evaluate the task relationships 
and constraints to be sure the results are logical. Therefore, Project 2016 allows project 
managers to modify, add, or delete task relationships and task constraints throughout the 
planning process. Task constraints can be modified by using the Task Information dialog 
box Advanced tab.

Task relationships can be added, deleted, or modified in the following ways:

•	 Using the Predecessors column of Gantt Chart view

•	 Using the Task Information dialog box Predecessors tab

•	 Double-clicking the link line in Gantt Chart and Network Diagram views and using 
the Task Dependency dialog box

Although a project may be set to Auto Scheduled, ultimately the project manager of 
the project has control over the scheduling of tasks. For example, a project manager can 
add, delete, or change task relationships to adjust the project schedule. A project man-
ager can also add task constraints such as constraint deadlines, constraint types, and/or 
constraint dates to further control how tasks are being scheduled.

Modifying Dependencies and Constraints

After reviewing the project schedule, you want to make a few adjustments to the way the 
tasks are being scheduled. You will add a deadline to a task to ensure the task is com-
pleted on or before a certain date. You will also change a task’s constraint type and change 
a task relationship.

In this exercise, you will modify task dependencies and task constraints.

To Modify Task Dependencies and Task ConstraintsPM01.13 

SIDE NOTE 
Task Constraints
Changing the constraint 
from As Late As Possible 
to As Soon As Possible 
allows the task to begin 
once its predecessor 
tasks are complete.

a. Double-click Reserve golf course (Task 5), and then click the Advanced tab in 
the Task Information dialog box.

b. Click in the Deadline box, and then type 5/20/2019. Click OK. Note that the  
Green arrow indicator on the Gantt chart indicates the task must finish by this date.

Deadline task
constraint

Figure 51 Modified task constraint 
Microsoft Project 2016, Windows 10, Microsoft Corporation
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c. Select Create volunteer list (Task 12). If necessary, right-click the task, and then 
click Scroll to Task  to view the task and its predecessor in the Gantt chart.

d. Press I to add a blank task row. Type Schedule celebrity appearances for the 
task name. Press T, type 1w, and then press T. Press T two more times, 
type 11 in the Predecessor column, and then press J.

e. Select Create tournament website (Task 7). Right-click the task, and then click 
Scroll to Task  to view the task and its predecessor in the Gantt chart.

f. In the Gantt chart, double-click the link line between Tasks 6 and 7 to open the Task 
Dependency dialog box.

SIDE NOTE 
Changing 
Dependencies
You can also type in a 
task dependency in the 
Predecessor column 
such as 6SS.

If you have di¢culty determining which link line is between Tasks 6 and 7, zoom in 
on the Gantt chart.

Troubleshooting

g. In the Task Dependency dialog box, click the Type arrow. Click Start-to-Start.

Task Dependency dialog box

Figure 52 Task Dependency dialog box 
Microsoft Project 2016, Windows 10, Microsoft Corporation

h. Click OK.

Start-to-Start
predecessor

Start-to-Start link
line in Gantt chart

Figure 53 Start-to-Start task dependency set 
Microsoft Project 2016, Windows 10, Microsoft Corporation

i. Select Sign volunteer contracts (Task 14). Press 2 on the keyboard to enter Edit 
mode. Select the word "Sign" and then type Mail to rename the task "Mail volunteer 
contracts." Press J to accept the change.

j. Double-click Begin online registrations (Task 8). Click the Advanced tab.
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k. Click the Constraint type arrow, and then select Start No Earlier Than. In the 
Constraint date box, type 6/21/19. Click OK. Notice how this constraint changed 
the scheduled finish date of the project. Also, note the Constraint indicator in the 
Indicators column.

Start and finish
dates change due
to task constraint

Constraint
indicator

Figure 54 Constraint indicator 
Microsoft Project 2016, Windows 10, Microsoft Corporation

l. Save  the project.

If a project is scheduled by Start date, another way to modify task dependencies is to 
create lag time or lead time. Lag time moves a successor task forward in time so the Start 
dates between the tasks become further apart. Lead time moves a successor task back in 
time so the two tasks overlap and the Start date between the tasks gets closer. Lead time is 
the opposite of lag time and is sometimes referred to as negative lag. Lag time will likely 
extend the length of the project.

In projects, some tasks can be assigned to begin past the task’s original assigned start date  
by adding a lag time. For example, a task “website goes live” may have a successor task of 
“analyze website tra�c” with a Start-to-Start relationship. Although you can start analyzing 
website tra�c at the start of the website going live, it makes sense to wait a week or two  
before you begin analyzing data. In this case, you would add lag time to the dependency. Adding 
lag time to tasks on the critical path will increase the overall project’s duration. Lag time can be 
added by:

1. Double-clicking the link line between tasks in the Gantt chart or the Network Diagram.

2. In the Task Dependency dialog box, entering a duration in number or percentage format.

REAL WORLD ADVICE Using Lag Time in a Project

Adding Tasks to the Timeline

A timeline is used to display tasks, such as milestone tasks, in a simple compact format. 
The timeline can be used to display a summary of project plans. Timelines can also be 
shared with other Microsoft applications such as Microsoft PowerPoint 2016.

In this exercise, you will add tasks to the Timeline.

BK-PED-707292-JACOBSON-160388-Chp01.indd   43 24/11/16   3:14 PM



44 CHAPTER 1 | Microsoft Project 2016

Deleting Task Dependencies

After linking tasks and setting task dependencies, you may decide a dependency is no 
longer needed or was created in error. Project 2016 allows you to not only modify task 
dependencies but also delete task dependencies.

You realize the scheduling of these tasks does not work with your project plan, so you 
explore ways of adjusting how these tasks are scheduled.

In this exercise, you will modify task dependencies and task constraints.

To Add Tasks to the Timeline
a. Click Reserve golf course (Task 5), and then on the Task tab, in the Properties 

group, click Add to Timeline .

b. Click Begin online registrations (Task 8), and then on the Task tab, in the Properties 
group, click Add to Timeline .

PM01.14

Tasks added to the Timeline

Figure 55 Project Timeline 
Microsoft Project 2016, Windows 10, Microsoft Corporation

c. Save  the project.

To Delete a Task Dependency
a. Double-click Mail volunteer contracts (Task 14).

b. On the Task Information dialog box, click the Advanced tab.

c. Type a Constraint date of 9/17/2019, and then click OK.

PM01.15

d. On the Task tab, in the Schedule group, click Unlink Tasks . Note the task Start 
date did not change because a Constraint date has been set on the task.

Unlinked tasks

Figure 56 Gantt Chart view with unlinked task 
Microsoft Project 2016, Windows 10, Microsoft Corporation

e. Save  the project.
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Prepare Project for Printing Project Views
Various views can be printed in Project 2016. Prior to printing, it is important to set up 
the project view to the appropriate zoom, include any header or footer information, and 
be sure all printing options are set the way you desire. Printing options are found on the 
File tab in Backstage view. Backstage view is where you manage your project file and 
perform tasks such as saving, printing, and setting project options. In Backstage view, 
you can preview each page layout before printing. You can also view the status of your 
project and make related project changes in Backstage view. Backstage view displays in 
full screen to allow for more window space to work with relevant features.

When printing in Gantt Chart view, the printout will appear as it looks on your 
screen. For example, if you only want to print the Task Name column and the Gantt 
chart, move the split bar to the right edge of the Task Name column with a left click and 
drag before printing. If the split bar is in the middle of a column, Project will not print 
that column. The default is for a legend to appear in the bottom portion of each page in 
Gantt Chart view.

When printing in Network Diagram view, you may want to zoom in to view fewer 
tasks or zoom out to view more tasks. When printing from Calendar view, you should 
decide if you want to print a month calendar or a week calendar. If neither option fits your 
needs, you can customize a Calendar Print option.

A header or footer can be added to all views in Project 2016. However, adding a 
header in Gantt Chart view does not add a header to Calendar view. If you desire a header 
on Calendar view or Network Diagram view, you will need to add one in each view by 
clicking on the Page Setup link in the Backstage view Print option.

Preparing to Print in Gantt Chart View

You want to print the Gantt chart to show the team the charity golf tournament project 
plan you have started. Before printing, you will prepare your project views by adding 
your name to the header in the Gantt Chart view.

In this exercise, you will prepare to print in Gantt Chart view.

To Prepare for Printing in Gantt Chart View
a. Drag the split bar between the Entry table and the Gantt chart to the right edge of 

the Finish date column in Gantt Chart view.

PM01.16

If your screen does not display a column you want to print when you are in 
Backstage view, make sure the entire column is visible in Gantt Chart view. Project 
will not print a column if the split bar is even slightly covering the column.

Troubleshooting

b. Click the File tab, and then click Print. Your project will appear in the Preview pane 
on the right side of the screen.
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Figure 57 Gantt Chart in Preview pane

c. Click in the Preview pane on the right-hand side of the Project 2016 window. The 
preview will zoom so you can see more detail.

d. Click the Multiple Pages  button in the lower, right-hand corner of the Preview 
pane to view all pages of Gantt Chart view.

The printer displayed in the Printer list is determined by your installation and may be 
di¡erent than the printer shown in Figure 57.

Troubleshooting
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Multiple Pages button

One Page button

Figure 58 Preview pane navigation buttons

e. Click the Page Setup link. The Page Setup dialog box will open.

f. Click the Header tab. Click the Right tab, and then type your first and last name.

Page Setup link

Figure 59 Page Setup dialog box
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g. Click OK.

h. Click the One Page button  in the lower right-hand corner of the Preview pane 
to view one page of the Gantt chart along with your change to the header.

Name added in
Gantt chart header

Figure 60 Preview pane with header added

i. Click Back , and then Save  the project.

Preparing to Print in Calendar View

You may also want to print from Calendar view to give your team members a visual  
representation of what will happen week to week. Before printing, you will prepare 
Calendar view by adding your name to the header and  setting up the Calendar to print 
week by week.

In this exercise, you will prepare to print in Calendar view.

To Prepare for Printing in Calendar View
a. Click Calendar  on the View Bar.

b. Click the File tab, and then click Print.

c. Click the Page Setup link, and then click the Header tab. Click the Right tab, and 
then type your first and last name. Click OK.

d. To view the project tasks, click the list arrow for the starting date.

PM01.17
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of Calendar view

Figure 61 Preview pane with header added in Calendar view

e. Click 5/20/2019.

If you only see the month of April, use the view buttons in the lower right-hand 
corner of the preview window to scroll to the month of May in the preview pane.

Troubleshooting

f. Click Back .

g. Save  the project.

Preparing to Print in Network Diagram View

One of your team members has asked for a printout of the project’s task to be in a graphi-
cal format, not in Calendar or Gantt Chart format. Therefore, you decide to print the 
project tasks in Network Diagram view.

In this exercise, you prepare the Network Diagram view to print.

To Prepare for Printing in Network Diagram View
a. On the View Bar, click Network Diagram  view.

b. Click the File tab, and then click Print.

c. Click the Page Setup link, and then click the Header tab. Click the Right tab, and 
then type your first and last name. Click OK.

d. Click the Landscape Orientation arrow, and then click Portrait Orientation.

PM01.18 
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e. Use the Page Navigation buttons  to scroll through the pages 
that will print. Note the shape of the milestone tasks in the Network Diagram.

Portrait Orientation

Name added in header
of Calendar view

Figure 62 Preview pane with header added in Network Diagram view Portrait and Orientation

f. Click Back .

g. Save  the project, exit Project 2016, and then submit your file as directed by your 
instructor.
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 11. Explain the following terms to someone new to Project 2016 software:

a. Predecessor task

b. Successor task

c. Constraint

d. Milestone

 2. What is the purpose of a Gantt chart?

 3. Describe the components of the Project Information dialog box.

 4. Why is it important for a project’s base calendar to accurately reflect the available 
working time of a project?

 5. Describe the di¡erence between a Manually Scheduled and an Auto Scheduled  
project.

6. List the task durations and task duration abbreviations in Project.

7. How can a Note be applied to a task? When would a Note be applied to a task?

8. Describe at least three ways you can add task dependencies.

9. Describe at least three ways you can change a task dependency between tasks.

10. How do you add your name to the header of the Gantt chart?

Concept Check

Key Terms

24 Hours calendar 10
Auto Scheduled 18
Backstage view 45
Baseline 10
Calendar view 29
Constraint 3
Cost resource 3
Critical path 32
Critical task 32
Current date 10
Entry table 5
Finish date 9
Gantt chart 3
Gantt Chart view 5
Indicators column 6
Lag time 43
Lead time 43

Manually Scheduled 18
Material resource 3
Milestone 3
Network Diagram view 32
Night Shift calendar 11
Nonworking day 6
Note 20
Predecessor task 3
Project goal 2
Project Information dialog box 9
Project management 2
Project manager 2
Quick Access Toolbar 6
Resource 3
Row selector 5
Scope 3
Select All 5

Split bar 5
Standard calendar 10
Start date 9
Status date 10
Successor task 3
Task 3
Task dependency 3
Task duration 3
Task Information 20
Task Mode column 6
Task Name column 6
Timeline 5
Timescale 6
View Bar 6
Work resource 3
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Figure 63 

Visual Summary

Starting
a Project

Entering Project Tasks

Auto Scheduling a Project

Modifying Tasks in Calendar View

Modifying Tasks
in Network
Diagram View

Adding and Modifying Tasks in the Entry Table
Deleting Project Tasks in the Entry Table

Moving, Cutting, Copying, and Pasting
Project Tasks in the Entry Table

Preparing a Project Schedule Using
the Project Information Dialog Box

Modify a Project Calendar
Add Exceptions to the Project Calendar

Modify the Quick Access Toolbar and Collapse the Ribbon

Preparing to Print in Gantt Chart View
Preparing to Print in Calendar View
Preparing to Print in Network Diagram View

Modifying Dependencies and Constraints 

Adding Tasks to the TimelineAdding Task Dependencies

Deleting Task Dependencies
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Practice

Student data file needed:

 No data file needed

You will save your file as:

  pm01ch01BloodDrive_LastFirst.mpp

Organizing a Blood Drive at Your Community College
You have been asked by the student senate to be the project lead of a blood drive at 
your school to promote a cause that saves millions of lives each year. To demonstrate 
your project management skills, you decide to use Project 2016 to set up the plan for 
the blood drive. The senate would like to hold the blood drive in October. They note 
that the campus will be closed on September 27, 2019. You decide to use Project 2016 
to help determine a date for the blood drive. You are available to work on the planning 
of this project Wednesday through Friday, 8:00 AM to 12:00 PM.

a. Open a Blank Project. Click the File tab, and then click Save. Click Browse, and 
then navigate to the location where you are saving your files. Click in the File name 
box, type pm01ch01BloodDrive_LastFirst.mpp using your last and first name, and 
then click Save.

b. Click the Project tab, and then in the Properties group, click Project Information. 
Set the Start date to August 29, 2019. Click OK.

c. On the Project tab, in the Properties group, click Change Working Time . Click 
the Work Weeks tab, and then click Details. Select Monday and Tuesday. Click 
Set days to nonworking time.

d. Click Wednesday, press and hold S, and then click Friday. Click Set day(s) 
to these specific working times. Select row 2 in the specific working times grid. 
Press D to clear the 1:00 PM to 5:00 PM working times. Click OK.

e. Click the Exceptions tab in the Change Working Time dialog box. Enter the excep-
tion name College closed for inservice, and then press T. Click in the Start 
column in row 1. Change the start date in row 1 to September 27, 2019, and then 
press T. Click OK.

f. Click the Task tab. In the Tasks group, select the Mode arrow, and then click Auto 
Schedule.

g. Be sure the View Bar is showing on the left-hand side of your screen. (Hint: If the 
View Bar is not showing, right-click GANTT CHART on the left-hand side of your 
screen, and then click View Bar from the shortcut menu.)

h. If necessary, add the Timeline below the ribbon. (Hint: If the Timeline is not  
showing, click the View tab, and then in the Split View group, click Timeline.)

i. Enter the following tasks and durations into the Entry table:

TASK NAME DURATION

 1 Select blood drive campus location 4h

 2 Set blood drive goal 1h

 3 Form a recruitment team 2d

 4 Divide team roles and duties 2h

 5 Plan promotional strategies 4h

 6 Publicize the blood drive 1d

 7 Schedule appointments 2w

 8 Check site arrangements 4h

 9 Get visitor parking passes 2h

10 Email appointment reminder messages 4h

11 Post directional arrows and posters around campus 1h

Information 
Technology
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j. On the Quick Access Toolbar, click the Spelling button to check the spelling of the 
task names.

k. Click Publicize the blood drive (Task 6). Press I to add a blank task. With the 
new blank task selected, add the task name Create promotional materials. Assign 
this task a duration of 5 hours.

l. Click the row selector of Get visitor parking passes (Task 10). While holding 
the mouse, drag Task 10 after Email appointment reminder messages (Task 11). 
Release the mouse. Get visitor parking passes is now moved to become Task 11.

m. Click Publicize the blood drive (Task 7). Click the Task tab, if necessary, and then 
in the Insert group, click Task  to add a new task. Enter the task name Contact 
local businesses, and then add the duration of 6 hours. Task 7 is now Contact local 
businesses.

n. Double-click Contact local businesses (Task 7) to open the Task Information dia-
log box. Click the Notes tab. Type Contact the webmaster to place blood drive 
info on college website. Click OK.

o. Click the File tab, and then click Print. Click the Page Setup link, and then  
click the Header tab. Click the Right tab, and then type your first and last name. 
Click OK.

p. Click the Back button  to exit Backstage view and return to Gantt Chart view. 

Click Network Diagram  on the View Bar. Click Post directional arrows and 
posters around campus (Task 13). Click the Task tab, if necessary, and then in 
the Insert group, click Task  to add a new task in Network Diagram view.

q. Double-click the new task, and then type the task name Blood drive begins.  
Type a duration to 0 days to make this task a milestone task. Click OK. Note the 
shape of the Milestone task in the Network Diagram view.

r. With Blood drive begins (Task 13) selected, in the Properties group of the Task tab, 
click Add to Timeline. The milestone is now added to the Timeline.

s. Click Gantt Chart  on the View Bar to switch to Gantt Chart view.

t. Move Blood drive begins (Task 13) after Post directional arrows and posters 
around campus (Task 14) to make it the final project task.

u. Select Tasks 1-14. Click C + 2 to link all the tasks.

v. Select Schedule appointments (Task 9), and then change the duration from 2 
weeks to 20h.

w. Change the relationship to a Start-to-Start relationship between Schedule 
appointments (Task 9) and Check site arrangements (Task 10).

x. Click Email appointment reminder messages (Task 11). On the Task tab, in the 

Properties group, click the Information  button to open the Task Information 
dialog box. Click the Advanced tab. Add the Constraint date October 9, 2019.

y. Select the task names. Click the Format tab. In the Columns group, click Wrap 
Text twice

z. Save your pm01ch01BloodDrive_LastFirst project file, exit Project 2016, and 
then submit your file as directed by your instructor.
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Planning Your Job Search Portfolio
You will be graduating in May 2019 from your program of study at your local commu-
nity college. You decide it is time to start preparing for your job search portfolio. Due 
to other school obligations, you can only dedicate 10 hours a week to work on your 
portfolio. To stay on task, you will work two hours per day Monday through Friday. 
You have afternoon classes, so you will set 8:00 AM to 10:00 AM as working time. The 
remainder of the days and times will be set to nonworking time. You begin brainstorm-
ing a list of tasks, and you realize there are many tasks that need to be completed. To 
be sure you don’t miss an important step, you decide to use Project 2016 to help you 
organize and keep track of your task list.

a. Open a blank Project 2016 file, and then save it as pm01ch01JobSearchPortfolio_
LastFirst.mpp in the location where you store your files.

b. Since you are just starting your portfolio, you will leave the default schedule of 
Project Start Date. Set the Start date to February 1, 2019.

c. Change the project calendar to set working time to Monday through Friday, 8:00 
AM to 10:00 AM. The remainder of the days and times will be set to nonworking 
time.

d. Add the exception Spring Break to set March 11–15, 2019, as nonworking days.

e. Set the project to Auto Scheduled so the task dates are calculated by Project 2016.

f. Enter in the following tasks:

TASK DURATION

 1 Purchase portfolio supplies 2 h

 2 Get an uno�cial transcript 4 h

 3 Identify references 1 w

 4 Write resume 6 h

 5 Create a resume in PDF format 2 h

 6 Write a cover letter 3 h

 7 Conduct online job search 5 d

 8 Gather work examples for portfolio 10 h

 9 Conduct a mock interview 3 h

10 Send resumes to potential employers 2 h

11 Compile portfolio 4 h

g. Select Create a resume in PDF format (Task 5). Add a note to Task 5 Use a PDF 
resume for online applications.

h. With Task 5 still selected, in a Project 2016 view of your choice, add a new task 
Edit resume with a duration of 2 hours. The Edit resume task becomes Task 5.

i. Move Write a cover letter (Task 7) after Conduct online job search (Task 8).  
The Write a cover letter task becomes Task 8.

j. Add the task note Contact Career Resource Center. to Gather work examples for 
portfolio (Task 9). Click OK.

k. Change the duration of Identify references (Task 3) to 8 hours.

Problem Solve

Student data file needed:

  No data file needed

You will save your file as:

 pm01ch01JobSearchPortfolio_LastFirst.mpp

Sales & 
Marketing
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l. In Gantt Chart view, move the split bar to the right edge of the Predecessors col-
umn. Link Tasks 1–12 in the order they appear in the Entry table.

m. If the Timeline is showing, remove it from Gantt Chart view.

n. Hide the View Bar.

o. Hide the Task Mode column. (Hint: Right-click the Task Mode column.)

p. Add your first and last name as a header on the right tab of Gantt Chart, Network 
Diagram, and Calendar views. Change the Calendar view to Week. Return to Gantt 
Chart view.

q. Save your project, exit Project 2016, and then submit your file as directed by your 
instructor.

Why are exceptions added to a project’s calendar? What could be the result to a proj-
ect’s schedule if exceptions were omitted from the Project calendar?

Critical
Thinking

Perform 1: Perform in Your Life

Student data file needed:

  No data file needed

You will save your file as:

 pm01ch01BusinessPlan_LastFirst.mpp

Preparing a Business Plan
You have decided to start a virtual assistant business in which you work from your 
home o¡ering o±ce-related assistance and software solutions to local businesses. In 
order to secure funding for your business, you must prepare a detailed business plan. 
You decide to use Project 2016 to help organize the details of preparing your business 
plan. Your goal is to have the business plan completed by July 1, 2019. Based on your 
knowledge of preparing a Project 2016 file, you will:

a. Determine if you will set your project to schedule by Start date or by Finish date. 
As directed by your instructor, explain why you chose Start date or Finish date.

b. Adjust the Standard calendar for a work week maximum of 20 hours of working 
time. Any combination of days and hours is acceptable. Add a minimum of one 
exception to the calendar.

c. As directed by your instructor, explain the adjustments made to the calendar and 
detail any exceptions to the calendar.

d. Determine whether you want your project to be Auto Scheduled or Manually 
Scheduled. As directed by your instructor, explain how you set Project 2016 to 
schedule your project and why you chose that method.

e. Research preparing a business plan. There is more than one way to prepare a 
business plan. (Hint: Open Excel 2016, and in the Search box, type business plan.)  
You will use Project 2016 to enter a list of tasks you would need to complete to 
prepare your virtual assistant business plan. You must list a minimum of ten key 
tasks to preparing a business plan. For example, Step 1 (Task 1) may be “Define 
business vision.”

f. After identifying a minimum of ten key steps to preparing a business plan, determine 
task durations based on your research and/or knowledge of preparing a business 
plan. Take into consideration your time available to work on the tasks as well.

g. Create appropriate task relationships (dependencies) for the project tasks. Assign 
a relationship other than Finish-to-Start to at least one task. As directed by your 
instructor, explain why you selected the task relationships for the project tasks.
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h. Add at least one task constraint. As directed by your instructor, explain why you 
added the constraint and how it a¡ects the project plan.

i. Add your first and last name as a header in Gantt Chart, Network Diagram, and 
Calendar views. Save your project as pm01ch01BusinessPlan_LastFirst.mpp in 
the location where you store your files.

j. Exit Project 2016, and then submit your file as directed by your instructor.
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